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Disclaimer:    The instructions and advice presented in this software and documentation 
are in no way intended as a substitute for medical counseling.    Consult your physician 
before under taking any exercise program.    Discontinue the RELAXIZE exercises and 
consult a physician if you experience pain while doing the exercises.    The developers 
of the software and its distributors are not liable for any injury or health impairments that 
occur to any person using the exercises suggested in the software.



Contents Using RELAXIZE for Windows

What is RELAXIZE for Windows?

RELAXIZE for Windows is a tool for helping to prevent computer injuries, such as 
Carpal Tunnel Syndrome.    If properly installed, RELAXIZE will automatically begin 
running when you start Windows.    RELAXIZE will run in the "background" as you work 
with other applications.

A small dialog box will appear in the lower right corner of the screen when it is time for a 
break.    Select the Yes button to begin exercises or the No button to continue working.    
RELAXIZE includes ten exercise windows which appear during break time.    Each 
exercise window contains exercises for reducing stress and strain on the body caused 
by working at a computer for long time periods.

More information . . .

RELAXIZE Menu Bar
Choose a Command
Set Timers
Start Times
Exercise Windows
Start Exercises Before Scheduled Breaks
Pause Button
Repeat Button
Continue Button
Cancel Button
Sound
Control Menu
Screen Savers

Re-Start RELAXIZE

RELAXIZE will automatically start running in the "background" when Windows begins 
running. You can exit from RELAXIZE and later re-start the program.    Open the StartUp 
group window and double-click on the RELAXIZE icon.    RELAXIZE will start running in 
the "background" again.



RELAXIZE Menu Bar

File Menu Command

Start Exercises
Manually start RELAXIZE exercises before scheduled exercise break begins.

Exit
Exit from RELAXIZE program.    RELAXIZE will stop running in the "background" until 
restarted.

Options Menu Commands

Set Timers
Display window for changing posture, work and break timer settings.

Start Times
Display window to set exercise break time schedule.

Exercise Windows
Recommended exercises for relaxing and relieving stress.

Sound
Turn RELAXIZE beeper on and off.

Help Menu Commands

Index
Help topic index.

How to Use Help
Help instructions.

About RELAXIZE
Copyright information about RELAXIZE.



Choose a Command

Mouse

1. Point to a menu title and click.    The menu window will appear.

2. Point to a command and click.

Keyboard

1. Press ALT and the underlined letter of a menu title.    The menu window will
appear.

2. Press the underlined letter of a command or use the UP and DOWN arrow
keys and press ENTER to choose the highlighted command.



Set Timers

When you install RELAXIZE, default timer values are installed for the posture window 
( 1 minute), work period timer (60 minutes) and break period timer (5 minutes).    The 
posture timer tells RELAXIZE how long to display the posture exercise window.    The 
work timer determines how long RELAXIZE runs in the background while work.    The 
relax timer determines the length of your break time.

We recommend you use the default timer values to help prevent injuries.    However, 
you can change the timer values while RELAXIZE is running.

1. Choose Set Timers from the Options menu.

2. Point and click or press TAB to move cursor to timer field you want to reset.

3. Change the timer value by editing the field or use the spin buttons to the right
of each timer field.    Point to the UP arrow and click to increase the timer value.
Point to the DOWN arrow and click to decrease the timer value.

4. Select the Save button to save the new timer settings and return to the RELAXIZE
menu.

Select the Cancel button to cancel new timer settings and/or return to the 
RELAXIZE menu.

Note:    Exercise Start Times will override the work period timer.



Control Menu

Open the RELAXIZE Control Menu

Mouse
Point to the Control Menu box in the upper-left corner of the window and click.
Do not double-click or you will close the window.

Keyboard
Press ALT and SPACEBAR.

Control Menu Commands

Restore
Returns the window to its previous size and position before it was maximized to full size 
or minimized to an icon.

Move
Allows the window to be moved to another position on the screen.    When you choose 
Move a four directional arrow pointer appears.    Use the mouse or arrow keys to move 
the window, then release the mouse button or press ENTER.

Size
Allows you to change the size of the window.    When you choose Size a four directional 
arrow pointer appears.    Use the mouse or arrow keys to change the window's size, 
then release the mouse button or press ENTER.

Minimize
Reduces the window to an icon.

Maximize
Enlarges the window to full screen.

Close
Closes window and exits from RELAXIZE.



Exercise Windows

Select Exercise Windows

RELAXIZE includes ten exercise windows that can appear during break periods.    The 
exercise time remaining for each window is displayed in the status bar located at the 
bottom of the window.

RELAXIZE defaults to displaying each exercise window consecutively during break 
time.    We recommend you display each exercise window during break time to help 
prevent injuries.    You can choose which exercise window(s) not to display.    However, 
you cannot change the order exercise windows are displayed.

1. Choose Exercise Windows from the Option menu.    The exercise window list
will appear.

A check mark to the left of the exercise window name indicates that the window
will be displayed during break time.    No check mark indicates the window 
will not be displayed.

2. Point and click to remove or place a check mark next to an exercise window
name.    Keyboard users can use the arrow keys to highlight an exercise window
name and press ENTER to remove or place a check mark.    At least one 

exercise
window must be displayed during break time.

Note: RELAXIZE uses the break period timer settings and the number of
exercise windows marked for display to calculate the length of time each
exercise window is displayed.



Contents for Computer Injury Health Effects

The majority of people diagnosed with repetitive strain injuries, such as Carpal Tunnel 
Syndrome, are performing repetitive tasks in the workplace or home involving the use of 
hands and fingers.    During the past decade the number of computer related injuries 
has increased dramatically.

Expanding computer use has caused concerns about the health effects.    Employees 
are complaining about eye strain, headaches, stress and neck, back and arm pain.    
These health effects are having a negative effect not only on employee morale and 
productivity, but with home computer users as well.

Costs
Causes
Frequency
Symptoms
Prevention

For more information on computer injuries you can contact OSHA:

Occupational Safety and Health Administration
U. S. Department of Labor
Technical Data Center, Room N2439
200 Constitution Avenue, N.W.
Washington, DC    20210



Costs

Computer injury costs increased substantially during the last ten years.    Disability 
benefit expenditures (including workmen's compensation premiums) are increasing 7% 
annually.

One cost study suggests that computer injury costs may represent 8% of labor costs:

3.5% direct
3.5% hidden (production lost)
1.0% management
-------
8.0% of payroll

U.S. disability cost in 1986 was $87.3 billion paid to employees instead of wages.
$80 billion for medical expenditures and $2.7 billion for rehabilitation.
$170 billion is total amount paid by private sector.    (4% of GNP)

Carpal Tunnel Syndrome (CTS) injuries are included in a broader category called 
"motion injuries".    Motion injuries may comprise 50% of workmen's compensation 
cases by the year 2000.    ( Business Week 1/89)

National Institute for Occupation Safety and Health Administration (NIOSH) estimates 
that an average CTS case costs $3000 in benefits and up to $40,000 in direct medical 
costs.    A severe CTS case can cost $100,000 in medical and administrative and lost 
productivity.



Causes

Today's computer users work at the keyboard for hours at a time never varying their 
activity or body position.    Human bodies are not meant to remain in a sedentary 
position, nor is the hand designed for repetitive movements without rest.

Repeated stressful motions, and extension of the wrists in the same position for long 
periods of time may cause enlarged tendons and chronic irritation of the median nerve. 
The problem develops when the same limited assortment of tasks are done repeatedly 
day in and day out.

Poor posture compounded by use of poorly designed furniture.    Improper keyboard 
height and position may cause wrist, neck and shoulder stress.

Low quality computer monitors may flicker making it difficult for the eyes to focus.    
Display screen glare from improper positioning and improper lighting also contribute to 
eye strain. 

Pregnancy can result in and/or exacerbate Carpal Tunnel Syndrome.    Water retention 
will cause pain. Symptoms usually disappear after delivery of the child.



Frequency

Approximately 26,000 Carpal Tunnel Syndrome (CTS) operations are done each year. 
Business Week (1/89) reports that injuries rose from 20,000 in 1983 to 74,000 in 1987.

In 1986 the U.S. Department of Labor estimated that about 600,000 computer related 
jobs were at risk for CTS.    Bureau of Labor Statistics - 61% of occupational illness in 
1991 were computer injuries.    In 1982 the figure was 21%.    U.S. Department of Labor 
says CTS and other cumulative trauma disorders cause 48% of industrial work place 
illnesses.    The disease affects over 5 million Americans.

CTS injuries have tripled in the last 10 years according to PC World Magazine.    CTS is 
the number one worker complaint to the Occupational Safety and Health Administration.

In 1992, 56% of illnesses reported to the Occupational Safety and Health Administration 
(OSHA) were computer injuries.    This compares with 18% in 1981 and 28% in 1984.    
The dramatic rise coincides with the proliferation of personal computer use.

Carpal Tunnel

The carpal tunnel is a narrow tunnel in the wrist formed by ligament and bone.    The 
median nerve, which carries impulses from the brain to the hand, passes through the 
carpal tunnel, along with the tendons that enable the hand to close.    When stressed, 
the tendons swell inside the tunnel and compress the median nerve.    CTS affects the 
sensitive nerves and the blood supply that feeds the hands and wrists.

CTS impact on American businesses is devastating.    The impact shows up in the work 
place in the form of fatigue, poor work performance, discomfort and pain, and poor 
employer/employee relations.

The high cost of treatment and lost productivity when the employee is absent for a long 
period, drains the company's ability to operate efficiently.    This can lead to more 
problems when other employees have to takeover the absent workers responsibilities.



Symptoms

Repetitive strain injury symptoms typically begin slowly and are mistaken for something 
else.    A person's hands or wrists may feel tired or sore.    These symptoms may appear 
after work or later at night after going to bed.    During sleep, blood may collect in the 
small blood vessels feeding the damaged hand tissue.    This situation will cause 
swelling.

Weakness and/or clumsiness of the hand, faulty sensation in the area strengthen by the 
median nerve.    Pain, numbness and weakness of the hand if not treated, i.e. Carpal 
Tunnel Syndrome can result in partial or complete disability of the hand according to the 
Center for Disease Control.

Numbness usually begins in the muscle below the thumb.    Frequently pain occurs at 
night during sleep.    Many times there is no sign of bruising or visible swelling.    Some 
days the individual feels fine and other days there is severe discomfort.

In addition, stiff neck and back muscles may result from poor posture caused by 
compensating for other areas of stress.

Visual problems such as eye strain and irritation or lost focus are among the most 
frequently reported complaints.

Consult a physician if you are experiencing these symptoms.



Prevention

Give hands frequent rests during heavy activity periods.    Taking a break every 30 
minutes can reduce muscle tension and improve productivity.    Use RELAXIZE to 
develop the habit of frequent breaks.

Computer operators should stretch frequently, moving head, neck, shoulders and arms 
briefly to balance muscle tension.    Individuals should be seated properly.    Work should 
be placed slightly behind and to the side of the keyboard at a comfortable reading 
distance and at a proper height to prevent a stoop-shouldered position.

Progressive muscle relaxation - sit comfortably; tense and relax the muscle groups of 
the shoulders, neck and back until you can identify when they are tense; then let your 
back, neck and shoulders go limp and concentrate on remaining relaxed for several 
minutes.    It may take a few weeks or more to master this relaxation procedure.

Your chair must provide proper support in relation to the typing surface, monitor height 
and floor surface for resting feet.    The wrist needs to be kept in an unbent position.    
Key- board level should be checked so that the arms are parallel to the floor.

The computer screen should be positioned at proper eye level.    The National Institute 
for Occupational Safety and Health Administration (NIOSH) recommends that the 
monitor be positioned 20-24 inches away from your face. The top of the screen should 
be a bit below your horizontal line of sight: 5-15 degrees is comfortable for most 
people's necks.    If a vision problem causes you to strain your neck, consult your eye-
care specialist about getting the proper glasses.

Eye strain can be reduced by arranging the workstation to avoid screen glare and 
improve lighting.    NIOSH recommends taking a 15-minute break after 2 hours of 
continuous work under moderate visual demands and a 15-minute break after 1 hour of 
continuous work under high visual demands.    Lighting should be adequate for the 
computer user to see the text and screen, but not so bright as to cause glare.

Above all else use common sense and recognize the potential for injury.



Ergonomics

Ergonomics is the study and design of work environments that promote comfortable and 
safe work.

We tend to adapt ourselves to work conditions imposed by computers, rather than use 
workstations that meet our body's needs.    Our eyes strain while focusing at the screen, 
our necks and backs strain by sitting in unnatural positions for hours.    We suffer arm 
and hand injuries caused by repetitive motions.    Many negative health effects can be 
avoided by taking simple measures.

Five keys to reducing computer related health problems are:

a.      Recognize that injury may occur with work requiring repetitive movements
b. Develop and maintain good posture habits
c. Take regular rest periods
d. Use ergonomic furniture
e. Proper lighting

A poorly designed workstation may cause stress to different areas of the body.    
Correcting ergonomic problems means changing work habits and rearranging the 
workstation or replacing furniture.

The following products will help prevent health problems:

1. RELAXIZE for Windows
2. Anti-glare VDT screen
3. Keyboard wristpads
4. Mouse wristpad or a trackball
5. Document holder
6. Adjustable chair
7. Computer desk with keyboard tray
8.      Telephone Headset 



Workstation Design

Individuals must have adequate work space to do the required job tasks.    Body size will 
influence chair design, work surface height and access to various workstation elements, 
such as the display screen.

RELAXIZE is a software product designed to make it easy to take a break.    It silently 
monitors computer use and reminds the individual to stop and rest.

Desk
An adjustable work surface will help provide adequate leg room for the individual to 
stretch out.    Stretching will relieve static load that results from sitting with the legs in a 
fixed position for long periods.    Desks should provide for the keyboard and mouse to be 
located at a height where the forearms are parallel to the floor while sitting.

Chair
Most computer users spend their time sitting.    A chair that properly fits the individual will 
provide adequate back and shoulder support to reduce fatigue.

Chair Height
Chair height is correct when the entire sole of the foot can rest on the floor or footrest 
and the back of the knee is slightly higher than the seat of the chair.    This position 
allows the blood to circulate freely in the legs and feet.

Monitor/VDT
The monitor should be located in front of you at eye level and within an arms length.
Position the document holder close and at the same level as the monitor to help reduce 
neck tension.    Prevent glare by positioning the monitor to minimize reflections.    Use a 
flicker free monitor and make use of the brightness and contrast controls.

Keyboards, mouse, wrist pads 
Keep the keyboard flat to prevent wrist extension.    Locate the keyboard at the same 
level or lower than the level of the elbow.    Don't strain fingers to reach keys, move the 
entire arm.    Use wristpads only to relax on when not typing.    Hold the mouse loosely. 
Use a mouse which doesn't require excessive finger pressure to operate.

Telephone Headset
Use the headset to prevent the stress associated with cradling the phone between the
neck and shoulder.



Copyright Notice

© Copyright 1993 by Changing Seasons Software, Ltd.    All Rights Reserved.

Under the copyright laws, this software and documentation cannot be copied, 
photocopied, reproduced, translated, or reduced to any electronic medium or machine-
readable form, in whole or in part, without the prior written consent of Changing 
Seasons Software, Ltd.

Changing Seasons Software, Ltd. warrants for a 30 day period commencing on the date 
you receive delivery of a copy of the program that, if properly installed and operated on 
a computer for which it was designed, the program will perform substantially in 
accordance with the documentation.    Changing Seasons Software, Ltd.'s liability shall, 
in any event, be limited to the purchase price of the program and shall not include 
consequential damages, such as loss or destruction of data resulting from use of the 
program.    Changing Seasons Software, Ltd. will not honor any warranty unless you 
own a registered copy of the program.



 Trademark

RELAXIZE is a trademark of Changing Seasons Software, Ltd.
Microsoft is registered trademark and Windows is a trademark of Microsoft Corporation.



Technical Support

We have tried to design RELAXIZE for easy use.    Still, we will be happy to help if you 
encounter a problem.    Contact us by one of the following methods:

Telephone    (608) 273-2739

Telephone contact is probably the best way to solve a problem.    It is easier to provide 
help when we can speak with you directly.

Please try to be in front of your computer with the program operating.    Diagnosing a 
software problem is difficult if you are not at the computer.

Fax (608) 273-1965

CompuServe ID number:    71371,731

Write - send correspondence to:

                                                  Changing Seasons Software, Ltd.
                                                  4466 Sentinel Pass
                                                  Madison, WI    53711-4725

We would appreciate comments or suggestions you have about RELAXIZE for 
Windows.



Start Times

You can set RELAXIZE exercises to start at specific times during your work schedule.    
For example, if your work schedule is 8:00 AM to 5:00 PM, you can set RELAXIZE to 
start exercises at 10:00 AM, 12:00 PM and 3:00 PM.    Exercise start times override the 
work period timer.

Set Exercise Start Time
Choose Start Times from the Options menu.

Mouse

Point and click on the start time you want to set for exercises to 
begin.    The click will place an "X" in the box to the right of the start
time.

Keyboard

Use the TAB key to highlight the start time you want to set.    Press the 
Space Bar to place an "X" in the box to the right of the start time.

An "X" in the box tells RELAXIZE to start the exercises at that time.    Follow this same 
procedure to remove an "X" from the start time box.    RELAXIZE will ignore start times 
with an empty box.

Add Start Time
1. Move cursor to Edit Time text box.
2. Enter the new time in the format HH:MM and press the TAB key.    The 

AM option button will now be highlighted.
3. Select AM or PM.    (Keyboard users can use the arrow keys.)
4. Press TAB to move to the Add button and press ENTER.    The new start 

time will be inserted in the proper position in the start time list. 
The start time list can contain up to ten different start times. 
RELAXIZE will not allow you to include more than ten start times.

Change Start Time
1. Move cursor to Edit Time text box.
2. Enter the new time in the format HH:MM and press the TAB key.    The

AM option button will now be highlighted.
3. Select AM or PM.    (Keyboard users can use the arrow keys.)
4. Select the start time to change.
5. Select the Change button.    The start time list will be re-sorted to 

reflect the time change.

Delete a Start Time



1. Select a start time to delete.
2. Select the Delete button.    The select start time will be removed from the list.

Save Start Time Changes
Select the Ok button to save all additions and changes made to the start time list and 
return to the RELAXIZE menu.

Cancel Changes
Select the Cancel button to cancel additions and changes made to the start time list and 
return to the RELAXIZE menu.



Pause Button

Selecting the Pause button will cause the timer for the currently displayed exercise to 
pause.    The exercise timer will stop counting down the remaining exercise time.    
Selecting the Pause button again will cause the exercise timer to resume counting down 
the remaining exercise time.

This feature is helpful for those instances when your exercising is interrupted.



Repeat Button

You can repeat an exercise before it disappears from the screen.    Selecting the Repeat 
button will cause the timer for the currently displayed exercise to reset to the beginning 
exercise time.

This feature will only repeat the exercise displayed at the time the Repeat button was 
selected.



Continue Button

You can shorten the time an exercise is displayed by selecting the Continue button.    
Using the Continue button will display the next exercise window or cause the RELAXIZE 
menu to disappear (become minimized) when the current exercise window is the last 
window.



Cancel Button

You can cancel your break and return to work any time before all the exercise windows 
are displayed.    Selecting the Cancel button will cause the current exercise window to 
disappear and reduce RELAXIZE to an icon.    RELAXIZE will begin running in the 
"background".



 Start Exercises Before Scheduled Breaks

You can start an exercise break before it is scheduled by restoring the RELAXIZE menu 
bar to full screen.    See Control Menu instructions for restoring RELAXIZE menu to full 
screen.

1. Select Start Exercises from the File menu.    A small dialog box will 
appear in the lower right corner of the screen.

2. Select the Yes button.    The dialog box will disappear and the first 
exercise window will appear.



 Uninstall RELAXIZE

Use the following procedure to uninstall RELAXIZE on your computer.

1. Delete the following files:

C:\WINDOWS\RLXSETUP.EXE
C:\WINDOWS\RELAX.INI
C:\WINDOWS\SYSTEM\SETUPKIT.DLL
C:\WINDOWS\SYSTEM\THREED.VBX
C:\WINDOWS\SYSTEM\SPIN.VBX
C:\WINDOWS\SYSTEM\VBRUN300.DLL
C:\RELAX\RELAX100.EXE
C:\RELAX\RELAX100.HLP

2. Delete the RELAXIZE icon and group window.

3. Use a text editor, such as the Windows Notepad program, to change the
Load statement in the WIN.INI file.
Example:    load =c:\wntsrman.exe,c:\relax\relax100.exe
Delete the characters with the strike through in the example.



 Screen Savers

You can use RELAXIZE with Windows' screen savers.    However, Windows' screen 
savers may cause a minor conflict with RELAXIZE.    For example, your screen saver 
may pop-up on the screen while an exercise window is displayed.    (Screen savers are 
normally set to pop-up after a preset time if the keyboard or mouse is not used.)    Press 
a key or move the mouse to have the exercise window reappear.



 Sound

RELAXIZE will beep each time an exercise window appears.    This is the program's 
default setting.    The RELAXIZE sound can be turned on and off to accommodate your 
work situation.

1. Choose Sound from the Option menu.

A check mark to the left of On indicates that the sound is turned on.    A 
check mark to the left of Off indicates that the sound is turned off.

2. Point and click to select On or Off.    Keyboard users can use the arrow 
keys to highlight On or Off and press ENTER.
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